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POTENTIAL EVAPOTRANSPIRATION FOR AUTOMATIC WEATHER STATIONS 

The program has been written to calculate daily reference crop (potential) evapotranspiration (ETo) 
from data collected by an automatic weather station.  The software allows the calculation of daily 
evapotranspiration by two approaches; 

• Daily: Weather data, recorded hourly (or at any other time step), are aggregated into daily 
means and totals which are used to calculated daily evapotranspiration (in mm/d). 

• Evapotranspiration is calculated for each time step of the weather data and aggregated into a 
daily total. 

The results are written to data files that can be printed, loaded into a spreadsheet or used as input to 
other programs (such as the Silsoe soil water balance).  Additionally a daily summary of the input, 
and derived, weather data is generated. 

The software may be installed on computers based on a single site within the department or section 
of a company, institute or organisation purchasing the software.  Copies may be made for backup 
purposes only.  It may not be copied for distribution, resale, hire or rental or any purpose other than 
the legitimate purposes above without the prior approval of Cranfield University. 

Whilst every effort has been made to ensure the validity of the algorithms used in the calculation 
equations, the accuracy of the calculated evapotranspiration depends upon the accuracy of the input 
data measurement, siting of the weather station and relevance of the chosen evapotranspiration 
calculation method.  Cranfield University takes no responsibility for matters arising from the 
application of the results of this program. 

AWSET 
Version 3 

© Cranfield University (2002) 
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1. INTRODUCTION 

1.1 Calculation methods 

The program offers the user alternative methods of evaporation / evapotranspiration calculation by 
combination equations from various sources.  Three of the methods calculate daily 
evapotranspiration only, using hourly (or shorter time step) data to calculate daily totals, means, 
maxima and minima and then calculate daily reference evapotranspiration (ETo) from the daily 
weather parameters. 

One method calculates the evapotranspiration for each time step of the weather data and aggregates 
those into a daily total. With this method, resistance factors for other surfaces can be used and the 
evapotranspiration flux (mm/h) for each time step can be calculated. 

One method is provided for estimating daily open water evaporation, Eo. 

1.1.1 Penman-Monteith Method 

This is based on the original form of the Penman-Monteith equation (Monteith, 1965 & 1981).  The 
equations used for ET0 are those recommended by the Food and Agriculture Organisation of the 
United Nations (FAO) using factors for a reference surface1 (Allen et al., 1999).  The method 
should be appropriate in all parts of the world and is identical to the ETsz recommended for the 
USA by the ASCE-EWRI (ASCE, 2001). 

1.1.2 FAO Modified Penman Method 

This uses the method of Doorenbos and Pruitt (1976).  The equations used are those presented by 
Smith (1988) for a grass reference crop.  The equation has widely used outside of UK, but has a 
tendency to overestimate ETo in temperate climates and is not generally recommended for use in the 
UK. 

1.1.3 Penman Method 

This uses the version of the Penman equation (Penman, 1948) for grass presented by MAFF 
(1967).  The look-up tables used in that publication are substituted by equations presented by 
Mason (1978).  The method is primarily intended for UK conditions.  A spreadsheet version of the 
equations used can be found in Hess and Stephens (1993). 

1.1.4 Penman-Monteith (time step method) 

The Penman-Monteith method can be used to calculate the evapotranspiration flux on an hourly, or 
other, timestep. The methods used are as presented in Allen et al. (1999). By selecting the 

                                                 

1 Defined as ‘the rate of evapotranspiration from a hypothetical crop with an assumed height of 12cm, a fixed 
canopy resistance of 70 s m-1, and an albedo of 0.23, closely resembling the evapotranspiration from an extensive 
surface of green grass of uniform height, actively growing, completely shading the ground and not short of 
water’. 
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appropriate resistance factors the method can be used to calculate the FAO reference ETo (Allen et 
al., 1999) or the ASCE-EWRI reference ETsz (ASCE, 2001)2.  

Resistance factors can also be entered for any other surface and the potential evapotranspiration can 
be calculated. 

1.1.5 Penman Open Water Method 

This uses the version of the Penman equation (Penman, 1948) for open water presented by Penman 
(1963). 

                                                 

2 The FAO ETo uses a daytime surface resistance of 70 s/m whereas the ASCE method uses 50 s/m. 
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2. INSTALLATION 

The AWSET program is supplied on two 3.5” disks and must be installed on the hard disk. 

• Insert the 3.5” disk labelled ‘Disk 1’ in the computer’s disk drive 

• Run SETUP.EXE. 

• This will create a folder called \AWSET3 on your hard disk with the program file in it.  It will 
also create a program group on your start menu. 

DO NOT INSTALL AWSET3 IN THE ROOT DIRECTORY OF YOUR HARD DISK, 
ALWAYS INSTALL IT TO A FOLDER. 
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3. RUNNING THE PROGRAM 

The main screen shows four menu options that are used to control the program. 

 

Figure 1. Main screen 

Each of the menus can be activated by ‘clicking’ with the mouse pointer or typing the letter that is 
underlined whilst holding down the <Alt> key.  Additionally, the main functions also have short-cut 
keys to allow them to be accessed directly using the <Ctrl> keys. 

The status bar shows the currently selected evapotranspiration calculation method and the station 
and data-file format filenames (see 3.1 below). 

3.1 Configure 

The configuration options allow description of the ET calculation method, output requirements, input 
data file format and the weather station parameters.  

3.1.1 Options 

3.1.1.1 ET method 
The options screen (Figure 2) is used to define the ET calculation method and output requirements.  

If the Penman-Monteith (time step) method is chosen, then the reference surface should be selected. 
In addition, the method for calculating aerodynamic resistance can be set. If the ‘resistance for trees’ 
box is not checked, then the resistance is calculated from equation 22 (Allen et al., 1981). For tress, 
equation 71 can be used (Thompson et al. 1981). 
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Figure 2 Options screen 

3.1.1.2 Synoptic hour 
The synoptic hour is the hour at which evapotranspiration will be calculated for the previous 24 
hours.  Conventional (manual) weather stations are only read at certain times of the day, therefore 
readings are usually summarised at a particular synoptic hour (e.g. 0900GMT in the UK).  
Alternatively, with automatic weather stations, evapotranspiration may be calculated for calendar 
days (midnight to midnight) by setting the synoptic hour to zero. 

3.1.1.3 Output requirements 
Three output files may be selected; 

þ Summary writes a daily summary of the input weather data and derived values (including ETo) 
to a file with the name filename.SUM. 

þ ETo and rainfall only writes the date, daily ETo and daily rainfall to a file with the name 
filename.ETO. 

þ ET flux writes the date, time and ET rate in mm/h to a file with the name filename.ETF. 
(only available for the time step method) 

Where filename is the name of the weather data file. Each of the output files is written in ASCII 
format and can be loaded into a word processor or spreadsheet. 

The options are saved when you click on OK. Clicking on Cancel will revert to the previous 
options. NB. The option settings are preserved between sessions and therefore do not need to be 
reset each time the program is run. 
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3.1.2 Data File Format 

The data file format screen (Figure 3) allows the user to specify the format of the data file containing 
the automatic weather station data.  The data file should be ASCII (i.e. not binary) and data should 
be in columns with one row for each time step of the data. 

Number of columns Defines the number of columns of data in the data file. 

Separator Defines the way the columns are separated.  There are three 
options; 

• Space(multiple spaces are treated as a single separator) 

• Comma 

• Tab 

Time step (hrs) The time step (in hours) of the data should be set.  This allows 
integration of rates (e.g. conversion of radiation in W/m2 to MJ/m2).  
The time step cannot be varied within one data file. The minimum 
time interval allowed is 5 minutes. 

One file per day Some weather stations record each day’s data in a separate data 
file, rather than a single data file for all the data. If this is the case 
then the ‘one file per day’ box must be checked. 

NB. If the data are stored in separate data files for each day, then 
the first record for 00:00:00 relates to the last timestep of the 
previous day, therefore, to calculate values for a single day requires 
the data files for that day and the previous day to be selected. 

The following check boxes allow specification of what sensors are used, the units in which data are 
recorded and the column in which the data are stored. 

If the date is recorded in the form DD MM YY (i.e. separated by spaces) then you need only 
specify the column of the day and it is assumed that month and year are in the next two columns. 

The DD/MM/YY format can accept two- or four-digit years. If two-digit years are used, then a 
value greater than 50 implies 19xx (twentieth-century) and a value equal to or less than 50 implies 
20xx (twenty-first century) as specified by BSI DISC PD2000-1:1998. 
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Figure 3  Data file format configuration 

The data file configuration may be saved (using Save or Save As from the File menu) and loaded 
using Load. By this means, a library of data file configurations can be created. 

3.1.3 Station Parameters 

Before calculations can be made, it is necessary to set a number of station parameters (Figure 4).  
Each item on the form can be accessed using the mouse pointer and left mouse button, or pressing 
the letter underlined whilst holding down the Alt key. 

 

Figure 4  Station parameter configuration 
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3.1.3.1 Station Name 
This is not used in calculations but is written to identify the station. 

3.1.3.2 Latitude, Longitude & Altitude 
The latitude and longitude3 of the station (in degrees and minutes) and altitude (in metres) can be set 
using the scroll bar.  The scroll bar can be set using the mouse or the arrow keys on keyboard. 

3.1.3.3 Time zone 
The time zone is used along with the longitude, in the calculation of potential solar radiation if the 
time step method is used. This should be the time zone that the weather station clock is set to. 
Stations east of Greenwich will be positive and those west of Greenwich will be negative. 

3.1.3.4 Anemometer 
The calculations of evapotranspiration as based on wind speed at 2.0 m above ground level.  Wind 
speeds measured at different heights are adjusted to an equivalent wind speed at 2.0, using equation 
4, therefore the height of the anemometer (above ground level) should be entered. 

3.1.3.5 Ångström constants 
These are the constants used to estimate sunshine hours (if not measured) from solar radiation (see 
4.3.3 below).  The default values are a = 0.25 and b = 0.50 (Allen et al., 1998).  Locally applicable 
values may be calibrated based on observations of sunshine duration and measured solar radiation.  
Doorenbos and Pruitt (1976, Appendix VI) and Martínez-Lozano, et al. (1984) present 
experimentally determined values of a and b for a range of locations world-wide. 

The station configuration may be saved (using Save or Save As from the file menu) and loaded 
using Load. By this means, a library of station configurations can be created. 

3.2 File 

Once the data file and station parameters have been set you will see the names of the currently 
selected configurations appear in the status bar at the bottom of the AWSET screen. You may then 
proceed to calculate evapotranspiration.   

3.2.1 Single data file 

Select the data file to be processed by selecting Open from the File menu. 

                                                 

3 Only required if the time step ET method is used 
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Figure 5 File Open dialog box for single data files 

A dialog box will be displayed that allows you to browse directories to locate the required file.  By 
default only files with the extension ‘.DAT’ will be displayed.  Other filters may be applied by 
selecting from the ‘List of file type’ menu.  To display all files type ‘*.*’ in the File Name box (or 
any other extension filter). 

3.2.2 One file per day 

 

Figure 6 File Open dialog box for 'one file per day' option. 

If the data is stored in one file per day, then a different dialog box will be displayed. Select the folder 
containing the data files in the right hand box and all files in that folder with the extension *.DAT will 
be shown in the left hand box. 

• To select a ‘block’ of files, click on the first file, then, whilst holding the <Shift> key, click on the 
last file. 

• To select several files, click on each file in turn whilst holding down the <Ctrl> key. 
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3.2.3 Calculation 

Once the input file(s) has been selected, the calculation commences. As the calculations are being 
done, the current date and daily evapotranspiration (mm/day) are shown on the form. The 
calculation can be stopped at any time by pressing the <Esc> key. 

3.3 View 

When the calculation is complete, a summary of the daily weather data (Figure 7) can be viewed by 
selecting from the View menu. This option will not be available until calculations have been 
completed. 

• Parameters that have been estimated by the program are shown in blue.  

• Any days for which there was an incomplete record will be left blank. 

 

Figure 7  Example view of daily summary 

Selecting Close from the View menu will clear the display. 
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4. DAILY CALCULATION METHODS 

Evapotranspiration is calculated on a daily basis from; 

• maximum air temperature, °C 
• minimum air temperature, °C 
• mean daily vapour pressure, kPa 
• net radiation, MJ m-2 d-1 
• wind run, km d-1 

The following input data required by the Penman equation for each time step; 

þ Maximum and minimum (or mean) air temperature (required) 

þ Mean vapour pressure (calculated from relative humidity or wet & dry4 bulb temperatures). If 
no humidity measurements are available, daily mean vapour pressure is estimated from the 
saturation vapour pressure at the minimum air temperature. 

þ Mean wind speed (required). 

þ One of net radiation, solar (global) radiation or sunshine ratio (required).  
If net radiation is not available, longwave radiation is estimated from air temperature, sunshine 
ratio and humidity. 
If solar radiation is not available, it is estimated from the sunshine duration, time of year and 
latitude. If sunshine ratio (actual sunshine / potential sunshine duration) is not available, it is 
estimated from the solar radiation, time of year and latitude. 

The following data are optional and will be used if present, if not they will be estimated; 

o Barometric pressure.  If not available, this is estimated from the altitude (m) of the station. 

o Soil heat flux.  If soil heat flux is not available, it is estimated as a fraction of net radiation. 

o Rainfall.  This is not used in the calculation, but if available it is written to the output file for 
subsequent use. 

4.1 Humidity variables 

4.1.1 Mean vapour pressure 

If vapour pressure for each time step is given, this is averaged and used as input to the 
evapotranspiration equation. 

                                                 

4 If a wet and dry bulb psychrometer is present, the ambient air temperature will be used for the dry bulb 
temperature. 
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4.1.2 Relative humidity 

If relative humidity for each time step is given, then for each timestep, 






 +
=

2100
minmax TT eaeaRH

ed  (Allen at al., 1998) (19) 

4.1.3 Wet and dry bulb temperature 

If wet and dry bulb temperatures for each time step are given, then for each timestep. 

( )PTTeaed wetdryTwet −−= γ  (1) 

4.1.4 Saturation vapour pressure 
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4.1.5 Mean air pressure 
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0

00
0  (Burman et al., 1987) (3) 

4.1.6 Wind speed at 2 m 

The wind speed measured at height z, m, is converted to an equivalent 2 m wind speed (assuming 
that wind speed is measured above a reference grass surface) using 

4.2 Convert wind speed to 2m equivalent 

( )42.58.67ln
87.42

−
=

zU
U

z

 (Allen et al. 1989) (4) 
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Symbol Description Unit Value 
γ psychrometric constant for natural 

ventilation 
kPa °C-1 0.0008 

η constant lapse rate K m-1 0.0065K m-1 
A altitude m  
A0 altitude at sea level m 0m 
eaT saturation vapour pressure at 

temperature T 
kPa  

ed actual vapour pressure kPa  
g gravitational acceleration m s-2 9.8 m s-2 
P atmospheric pressure kPa  
P0 atmospheric pressure at sea level kPa 101.3kPa 
R specific gas constant J kg-1 K-1 287 J kg-1 K-1 
RH relative humidity %  
Tdry dry bulb temperature °C  
Tk0 reference temperature at sea level K 293.16K 
Twet wet bulb temperature °C  
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4.3 Radiation variables 

4.3.1 Maximum solar radiation 







 −= 405.1

365
2

4093.0 JSin
π

δ  (5) 

( ) ( )( )δω TanLTan *arccos −=  (Duffie & Beckman, 1980) (6) 
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 (Duffie & Beckman, 1980) (7) 

( ) ( ) ( ) ( ) ( )[ ]ωδδω
π

sincoscossinsin LLd
G

R r
sc

a +=  (Duffie & Beckman, 1980) (8) 

4.3.2 Day length 

ω
π
24

=N  (Duffie & Beckman, 1980) (9) 

4.3.3 Incoming solar radiation 

If no solar radiation data are available, then 

( )N
n

ssas baRR +=  (10) 

4.3.4 Actual sunshine duration 

If no sunshine data are available, then 









−= s

a

s

s

a
R
R

b
n

1
 (11) 

4.3.5 Soil heat flux 

( )138.0 −−= ii TTG  (Wright & Jensen, 1972) (12) 
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Symbol Description Unit Value 
δ solar declination rad  
ω sunset hour angle rad  
as Ångström constant -  
bs Ångström constant -  
G soil heat flux MJ m-2 d-1  
Gsc solar constant MJ m-2 d-1 118.08 MJ m-2 d-1 
J Julian day number (Jan 1 = 1) -  
L latitude rad  
n daylight hours h d-1  

N maximum daylight hours h d-1  

Ra extra-terrestrial radiation MJ m-2 d-1  
Rs incoming shortwave radiation MJ m-2 d-1  
Ti mean air temperature on day I °C  
 

4.4 Evapotranspiration calculation methods 

4.4.1 Penman-Monteith5 

4.4.1.1 Net radiation 
If net radiation is not measured it is estimated from; 

( ) sns RR α−= 1  (13) 
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4.4.1.2 Evapotranspiration 
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5 Methods are taken from Smith (1991). 
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Symbol Description Unit Value 
λ latent heat of vapourisation MJ kg-1  
∆ slope of vapour pressure curve kPa °C-1  
γ psychrometric constant kPa °C-1  
ρ atmospheric density kg m-3  
α albedo - 0.23 for grass 
κ von Karman constant - 0.41 
ε ratio of molecular weight of water to 

dry air 
- 0.622 

σ Stefan Boltzman constant MJ m-2 K-4 d-1 4.903 x 10-9 MJ m-2 K-4 d-1 
ε‘ net emissivity -  
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γ* modified psychrometric constant kPa °C-1  
ac empirical constant - 1.35 
al empirical constant - 0.34 
as Ångström constant -  
bc empirical constant - -0.35 
bl empirical constant - -0.14 
bs Ångström constant -  
cp specific heat of moist air kJ kg-1 °C-1  1.013 kJ kg-1 °C-1 
d zero plane displacement of wind 

profile 
m 0.08m for grass 

ea mean saturation vapour pressure kPa  
ed actual vapour pressure kPa  
ETaero aerodynamic term mm d-1  
ETo reference crop evapotranspiration mm d-1  

ETrad radiation term mm d-1  
f cloudiness factor -  

G Soil heat flux MJ m-2 d-1  

n bright sunshine hours h d-1  

P atmospheric pressure kPa  
R specific gas constant J kg-1 K-1 287 J kg-1 K-1 
ra aerodynamic resistance s m-1  

rc bulk surface resistance s m-1 70 s m-1 for reference grass 
Rn net radiation MJ m-2 d-1  
Rn net radiation MJ m-2 d-1  

Rnl net longwave radiation MJ m-2 d-1  

Rns net shortwave radiation MJ m-2 d-1  

Rs incoming solar radiation MJ m-2 d-1  

Ti mean air temperature for day i °C  
Tk mean air temperature K  
Tkv virtual temperature K  
Tmax maximum air temperature °C  
Tmin minimum air temperature °C  
Uz windspeed at height z m s-1  

Zoh roughness parameter for heat and 
water vapour 

m 0.0015m for grass 

Zom roughness parameter for momentum m 0.01476m for grass 
Zs screen height m 1.2m 
Zw height of windspeed measurement m 2m 
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4.4.2 Penman (1967)6 

4.4.2.1 Net radiation 
( )T565.031.5971868.4 −=λ  (Mason, 1978) (30) 
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( ) ( ) ( )nfedfTfRnl ..=  (35) 

nlnsn RRR −=  (36) 

4.4.2.2 Evapotranspiration 
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6 Methods are based on Hess and Stephens, 1993. 
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Symbol Description Unit Value 
λ latent heat of vapourisation J g-1  
α albedo - 0.25 for grass 
σ Stefan Boltzman constant mm K-4 d-1 1.9885 x 10-9 mm K-4 d-1 
∆ slope of vapour pressure curve mb °C-1  
γ psychrometric constant mb °C-1  
λ latent heat of vapourisation J g-1  
ea mean saturation vapour pressure kPa  
ed actual vapour pressure kPa  
Ea aerodynamic term mm d-1  
ETo reference crop evapotranspiration mm d-1  

f(ed) humidity factor -  
f(n) cloudiness factor -  
f(T) temperature term mm d-1  

f(U) wind function mm mb-1 d-1  
n bright sunshine hours h d-1  

N maximum daylight hours h d-1  

P atmospheric pressure kPa  
Rn net radiation mm d-1  

Rns net shortwave radiation mm d-1  

Rs incoming solar radiation MJ m-2 d-1  

T mean air temperature °C  
Tk mean air temperature K  
Tmax maximum air temperature °C  
Tmin minimum air temperature °C  
U wind speed km d-1  
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4.4.3 FAO Modified Penman7 

4.4.3.1 Net radiation 
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7 Methods are based on Smith (1988). 
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Symbol Description Unit Value 
α albedo - 0.25 for grass 
σ Stefan Boltzman constant mm K-4 d-1 8.727 x 10-12 mm  

K-4 d-1 
∆ slope of vapour pressure curve mb °C-1  
γ psychrometric constant mb °C-1  
a0 constant in estimation of c - 0.6817 
a1 constant in estimation of c - 0.0027864 
a2 constant in estimation of c - 0.0181768 
a3 constant in estimation of c - -0.0682501 
a4 constant in estimation of c - 0.0126514 
a5 constant in estimation of c - 0.0097297 
a6 constant in estimation of c - 0.43025 E-4 
a7 constant in estimation of c - -0.92118 E-7 
ea mean saturation vapour pressure kPa  
ed actual vapour pressure kPa  
ETo reference crop evapotranspiration mm d-1  

f(U) wind function mm mb-1  
k day - night wind ratio -  
n bright sunshine hours h d-1  

N maximum daylight hours h d-1  

P atmospheric pressure kPa  
RHmax maximum relative humidity %  
Rn net radiation mm d-1  

Rnl net longwave radiation mm d-1  

Rns net shortwave radiation mm d-1  

Rs incoming solar radiation MJ m-2 d-1  

Tk mean air temperature K  
U wind speed m s-1  
Ud daytime wind speed km d-1  
W weighting factor -  
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4.4.4 Penman open water  

4.4.4.1 Net radiation 
Net radiation, Rn, is calculated as in section 4.4.1.1 above except that an albedo, α, of 0.05 is used 
for open water. 

4.4.4.2 Evaporation 

( )edea
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Ea −





 +=  7.500638 

100
 0.621375

5.035.0  (Penman, 1963) (54) 

1+
∆

+
∆

=

γ

γλ EaRn

Eo  (55) 

λ, ∆ and γ are calculated as in section 4.4.1.2 above. 

Symbol Description Unit Value 
λ latent heat of vapourisation MJ kg-1  
∆ slope of vapour pressure curve kPa °C-1  
γ psychrometric constant kPa °C-1  
α albedo - 0.05 for open water 
ea mean saturation vapour pressure kPa  
ed actual vapour pressure kPa  
Ea aerodynamic term mm d-1  

Eo open water evaporation mm d-1  

Rn net radiation MJ m-2 d-1  
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5. TIME STEP CALCULATION METHOD 

Methods for the calculation of evapotranspiration for each time step are as for the Penman-Monteith 
method (section 4.4.1) except the following (Allen et al., 1998) 

5.1 Net radiation 

5.1.1 Net long wave radiation 

( ) 





 −−= 35.035.114.034.04

Rso
Rs

eTRnl dkσ  (56) 

5.1.2 Clear sky solar radiation 

( )RabaRso ss +=  (57) 
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12

ωωδδωω
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(Duffie & Beckman, 1980) (58) 

5.1.3 Hour angle 
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( ) ( ) ( )bbbSc sin025.0cos1255.02sin1645.0 −−=  (60) 
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 (61) 

5.1.4 Net radiation 

( ) RnlRsRn +−= α1  (62) 

5.2 Soil heat flux 

5.2.1 Daytime 

G = 0.1 Rn  (63) 

5.2.2 Night time 

G = 0.5 Rn (64) 

5.3 Potential evapotranspiration 

ETareoETradETp +=  (65) 
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5.3.1 Aerodynamic term 
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5.3.1.1 Aerodynamic resistance 
hcd 3

2=  (67) 

Zom = 0.123 hc (68) 

Zoh = 0.1 * Zom (69) 

For vegetation other than trees; 
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For trees 
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5.3.2 Radiation term 
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Symbol Description Unit Value 
δ solar declination rad  
η constant lapse rate K m-1 0.0065K m-1 
λ latent heat of vapourisation MJ kg-1  
∆ slope of vapour pressure curve kPa °C-1  
γ psychrometric constant kPa °C-1  
γ* modified psychrometric constant kPa °C-1  
ρ atmospheric density kg m-3  
σ Steffan-Boltzman constant MJ m-2 h-1 2.043 10-10 MJ m-2 h-1 
α albedo -  
κ von Karman constant - 0.41 
ε ratio of molecular weight of water to dry air - 0.622 
ω1 Solar time at time h – timestep (hours) rad  
ω2 Solar time at time h  rad  
as Ångström constant -  
bs Ångström constant -  
A altitude m  
A0 altitude at sea level m 0m 
cp specific heat of moist air kJ kg-1 °C-1  1.013 kJ kg-1 °C-1 
d zero plane displacement of wind profile m 0.08m for grass 
ea mean saturation vapour pressure kPa  
ed actual vapour pressure kPa  
ETaero aerodynamic term mm d-1  
ETp potential crop evapotranspiration mm d-1  

ETrad radiation term mm d-1  
G soil heat flux MJ m-2 d-1  
g gravitational acceleration m s-2 9.8 m s-2 
h local time   
h0 local time of solar noon   
hc crop height m  

J Julian day number (Jan 1 = 1) -  
Lm Longitude of measurement site °  
Lz longitude of standard meridian °  
LT latitude rad  
P atmospheric pressure kPa  
P0 atmospheric pressure at sea level kPa 101.3kPa 
R specific gas constant J kg-1 K-1 287 J kg-1 K-1 
ra aerodynamic resistance s m-1  

rc canopy resistance s m-1  

Rn net radiation W m-2  
Rnl net longwave radiation W m-2  

Rs incoming shortwave radiation W m-2  
Rso Clear sky shortwave radiation W m-2  
T mean air temperature °C  
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Tk mean air temperature K  
Tk0 reference temperature at sea level K 293.16K 
Tkv virtual temperature K  
Uz windspeed at height z km timestep-1  

Zoh roughness parameter for heat and water 
vapour 

m  

Zom roughness parameter for momentum m  
Zs screen height m 1.2m 
Zw height of windspeed measurement m 2m 
 

5.4 Surface parameters and resistance factors 

By default, the program calculates Evapotranspiration for a reference grass surface, defined as ‘a 
hypothetical crop with an assumed height of 12cm, a fixed canopy resistance of 70 s m-1, and 
an albedo of 0.23’8. 

Potential evapotranspiration for different land covers can be determined by selecting the land cover 
from the drop-down list under the station configuration option. 

Resistance and crop height data for different land covers are stored in a comma separated ASCII 
data file called ‘CROPFAC.TXT’.  The format of this file is described below.  Further land covers 
can be added to this file and they will automatically appear on the list when the program is run. 

The first line is a heading and is ignored by the program. 

Then, for each cover type; 

1. The first line contains the cover name, followed by the albedo.  In the case of incomplete covers, 
this refers to the albedo at full cover.  This is adjusted for incomplete cover within the program 
according to the leaf area index.  If the leaf area index is zero (or blank), as in the case of bare 
soil or water, then the albedo for full cover is used. 

2. The second line contains the label ‘hc’ followed by the crop height (m) in each month of the year 
(i.e. 12 values). 

3. The third line contains the label ‘rc(d)’ followed by the canopy resistance (s m-1) during the 
daytime for each month of the year. 

4. The fourth line contains the label ‘rc(n)’ followed by the canopy resistance (s m-1) during the 
night-time for each month of the year. 

5. The fifth line is contains the label ‘LAI’ followed by the average leaf area index for each month of 
the year. If no LAI is given, complete ground cover is assumed. 
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Table 1 Contents of CROPFAC.TXT 
 January February March April May June July August September October November December 

Reference Grass 0.23            
hc 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 
rc(d) 69.4 69.4 69.4 69.4 69.4 69.4 69.4 69.4 69.4 69.4 69.4 69.4 
rc(n) 200 200 200 200 200 200 200 200 200 200 200 200 
LAI 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 
MORECS Grass 0.25            
hc 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15 
rc(d) 89.8 89.8 73.7 62 50.1 66.7 66.7 75 77.2 80.3 88.2 89.8 
rc(n) 1350 1350 933.3 725 600 600 600 600 725 933.3 1100 1350 
LAI 2 2 3 4 5 5 5 5 4 3 2.5 2 
Bare Soil 0.2            
hc 0.001 0.001 0 0.001 0.001 0.001 0.001 0.001 0.001 0.001 0.001 0.001 
rc(d) 100 100 100 100 100 100 100 100 100 100 100 100 
rc(n) 100 100 100 100 100 100 100 100 100 100 100 100 
LAI             
Water 0.05            
hc 0.001 0.001 0 0.001 0.001 0.001 0.001 0.001 0.001 0.001 0.001 0.001 
rc(d) 0 0 0 0 0 0 0 0 0 0 0 0 
rc(n) 0 0 0 0 0 0 0 0 0 0 0 0 
LAI             
ASCE Reference Grass 0.23            
hc 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 0.12 
rc(d) 50 50 50 50 50 50 50 50 50 50 50 50 
rc(n) 200 200 200 200 200 200 200 200 200 200 200 200 
LAI 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 2.88 
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Software for the calculation of reference evapotranspiration from automatic weather 
stations 

AWSET V3 

Year 2000 Conformity 

This document describes how the AWSET V3 software conforms to the requirements for Year 
2000 conformity as specified in BSI DISC PD2000-1:1998. 

General: The AWSET V3 software uses the Gregorian Calendar and is applicable for dates after 1 
January 1900. 

Rule 1. General integrity. The AWSET V3 software will successfully cope with roll-over of 
dates. 

Rule 2. Date integrity. The AWSET V3 software will correctly calculate, manipulate and 
represent dates for the purpose for which it is intended. 

Rule 3. Explicit / implicit century. Where the original data file contains explicit representation of 
the year (i.e. four-digits), this is used in the AWSET V3 software. If the original data file contains 
two-digit years, then a value greater than 50 implies 19xx (twentieth-century) and a value equal to 
or less than 50 implies 20xx (twenty-first century). 

Rule 4. Leap years . The AWSET V3 software successfully identifies leap years (as defined by 
ISO 8601:1998) and correctly identifies 2000 as a leap year. 

Cranfield University 
Monday, 12 April 1999 
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Cranfield University Software Licence Agreement 

Terms and Conditions 

1. Cranfield University (hereinafter referred to as "the Owner") hereby grants to you the user, and you accept, a 
personal non-exclusive, non-transferable licence to use the enclosed disk, Program documentation and any related materials 
(hereinafter referred to as "the Software") on the terms and conditions set out herein. 

2. The Software is the Owner's proprietary product and is protected by Copyright Law.   The Owner reserves all 
rights of ownership and copyright in the Software as recorded on the diskette, and all subsequent copies thereof.   You the 
user own only the diskette on which the Software is recorded. 

3. The Software is distributed on the basis that they shall not be copied for further distribution or resale without the 
written permission of the Owner. 

4. You may: 

4.1 Install and use the Software on a computer. 

4.2 Transfer the Software onto another computer. 

4.3 Make full or partial copies of the Software for backup and archive purposes only, provided you label such copies 
clearly with our name, the name of the program and the date of this licence. 

4.4 Transfer the Software and the licence permanently to another party but only if you obtain our prior written 
approval and provided the other party agrees to these terms and conditions.   Any such transfer terminates your licence 
agreement. 

5. You may not: 

5.1 Transfer, assign, rent, lease, sub-licence, sell, give or otherwise dispose of this Software except as stated in these 
Terms and Conditions. 

5.2 Reverse compile, disassemble, or otherwise reverse engineer the whole or part of the Software. 

5.3 Modify, adapt or translate the Software in any way. 

5.4 Merge the whole or part of the Software with any other software other than that strictly required by the operating 
system stated in these Terms and Conditions. 

5.5 Reproduce, distribute or alter the Software documentation. 

6. Your responsibilities: 

6.1 You are responsible for installing and commissioning the Software onto your computer system(s) unless the 
Owner has agreed in writing to do so. 

6.2 You must ensure that proper security precautions are followed to secure backup copies of the Software, and that 
an effective control is kept on the number of copies of the Software. 

6.3 You must train the staff that run this Software to understand its purpose, operations and limitations.   You are 
responsible for how you use the Software. 
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6.4 You are responsible for the interpretation of the results produced by the Software. 

6.5 You must treat this Software and its documentation as confidential.   You must not disclose any part of it to 
another party without the Owner's permission. 

7. Term 

7.1. You are licensed to use the Program indefinitely. 

7.2 You may terminate your licence and this Agreement at any time by returning it to us together with the original 
media and user documentation of the Software. 

7.3 This Licence will terminate immediately if you fail to comply with any term or condition of this Agreement. 

 In the event of any termination you must destroy all full or partial copies of the Software resident on your 
computer system(s) in any form and you agree to provide to the Owner on request a written certificate of such destruction. 

8. Warranty 

 The Owner warrants that it has the right to licence the Software and that for a period of ninety (90) days from the 
date of purchase the diskette on which the Software is supplied will be free from all defects.   If a diskette or other media of 
the Software is defective the Owner will replace it at no charge provided that the defective item is returned to the Owner 
within ninety (90) days from the date of purchase. 

 The Owner warrants that the Software will perform substantially in accordance with the accompanying 
documentation. 

 EXCEPT  FOR  THE  LIMITED  WARRANTY  DESCRIBED  IN  THIS  PARAGRAPH  THERE  ARE  NO  
WARRANTIES  EITHER  EXPRESSED  OR  IMPLIED  BY  THIS  AGREEMENT.   NO  WARRANTY  IS  GIVEN  
AS  TO  THE  COMPLETENESS  OR  ACCURACY  OF  THE  SOFTWARE  NOR  THAT  IT  IS  ERROR-FREE  OR  
OF  A SATISFACTORY  QUALITY  OR  APPEAR  PRECISELY  AS  DESCRIBED  IN  ANY  DOCUMENTATION  
IN RESPECT  OF  THE  SOFTWARE.   ALL  OTHER  SUCH WARRANTIES  ARE  EXPRESSLY DISCLAIMED. 

9. Liability 

 You shall use the Software at your own risk and you agree that regardless of the form of any claim you have, the 
liability of the Owner and their authorised distributor shall not exceed the value of the Licence fee you have paid for the 
Software. 

 THE  OWNER AND THEIR AUTHORISED DISTRIBUTOR ACCEPT  NO  LIABILITY  FOR  ANY  LOSS  
OR  DAMAGE,  LOSS  OF  PROFIT,  LOSS  OF  CONTRACTS,  ANTICIPATED  SAVINGS  OR  ANY  OTHER  
DIRECT  OR INDIRECT  CONSEQUENTIAL  LOSS  OR DAMAGES  HOWSOEVER  CAUSED  EXCEPT  THAT  
WHICH  IS  UNLAWFUL  TO  EXCLUDE. 

 Notwithstanding the above, nothing herein shall exclude any liability for death or personal injury which arises as a 
result of the negligence of the Owner and/or their authorised distributor, their employees, servants or authorised 
representatives. 

10. General 

 Should any of the provisions of this Licence Agreement be ruled invalid under any law or Act of Parliament, they 
shall be deemed modified or omitted only to the extent necessary to render them valid and the remainder of the Agreement 
shall be upheld. 

11. Law 

 This Agreement shall be governed by and construed in accordance with the law of England and Wales and shall be 
subject to the jurisdiction of the Courts of England. 


